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Chapter 1

Getting Started
As you begin this book on the AutoCAD® program, I’m reminded of a 
quote by Chinese philosopher Lao-Tzu: “A journey of a thousand miles 
begins with a single step.” In much the same way, learning AutoCAD is 
something anyone can do by taking it one step at a time. And I promise that 
AutoCAD is much easier than walking a thousand miles!

By buying this book, you have already taken the first step in this journey. 
When you finish, you will have a solid understanding of AutoCAD.

In this chapter, you’ll  learn to:

▶▶ Sign in to Autodesk® 360 on the Dashboard

▶▶ Explore the AutoCAD 2015 for Windows user interface

▶▶ Set drawing units

Sign In to autodesk 360 on the Dashboard
Autodesk 360 is a cloud-based service that is integrated with AutoCAD. You 
have the option of automatically storing up to 5 GB of your drawing files in 
the cloud for free. The files you store in the cloud can be edited online and/or 
shared with others with your permission. 

The Dashboard is a new feature in AutoCAD 2015 that appears when you 
launch the program and whenever you create new file tabs. You can cre-
ate new drawings, access existing drawings, connect to AutoCAD 360, and 
receive notifications all on the Dashboard.

exercise 1.1: Configure autodesk 360
To begin, launch AutoCAD 2015.

 1. Click the Sign In button in the Connect section of the Dashboard 
(see Figure 1.1).
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F I G u r e   1 . 1   Clicking Sign In on the AutoCAD Dashboard

 2. Sign in with an Autodesk ID or email address and password. If you 
don’t already have an Autodesk ID, click the hyperlinked text reading 
“Need an Autodesk ID?” and create one online (see Figure 1.2).

F I G u r e   1 . 2   Sign in or create 
 an Autodesk ID

 3. After you sign in using an Autodesk ID, the Default Autodesk 360 
Settings dialog box appears. Check Enable Automatic Copy and Sync 
My Settings (see Figure 1.3). 

 4. Click the large Start Drawing button in the Get Started section of the 
Dashboard.

This loads the full AutoCAD user interface, which you will learn about in the 
next exercise.

▶

Take advantage of free 
cloud storage while you 
use this book. Storing 
your files offsite in the 
cloud is an effective 
backup strategy.
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F I G u r e   1 . 3   Setting Autodesk 360 options

using autodesk 360

Whenever you save your work in AutoCAD, a copy of your file will be uploaded  
to Autodesk 360 in the background. You can access this content at http:// 
360.autodesk.com (as shown here) or within AutoCAD from the Autodesk 360 
tab on the ribbon. You will learn about the ribbon in Exercise 1.4.

F I G u r e   1 . 1   Clicking Sign In on the AutoCAD Dashboard

 2. Sign in with an Autodesk ID or email address and password. If you 
don’t already have an Autodesk ID, click the hyperlinked text reading 
“Need an Autodesk ID?” and create one online (see Figure 1.2).

F I G u r e   1 . 2   Sign in or create 
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explore the autoCaD 2015 for Windows 
user Interface
Autodesk has recently released new versions of AutoCAD, including the 
AutoCAD® 2015 and AutoCAD LT® 2015 software. The two Windows versions 
look nearly identical and function in almost the same way. The main difference 
between them is that AutoCAD LT doesn’t support automation and some of the 
advanced 3D functions. Although this book was written using AutoCAD 2015 
running on Windows 7, you can use it to learn any of the current versions of 
AutoCAD.

exercise 1.2: explore the Graphical user 
Interface
Before you can use AutoCAD, you’ll need to familiarize yourself thoroughly with 
its graphical user interface (GUI). The AutoCAD 2015 (for Windows) user inter-
face is shown in Figure 1.4.

▶

AutoCAD for Mac 
has a user interface 
that is customized to 
the Mac experience. 
Although the Mac 
user interface is not 
covered in this book, 
its commands and 
capabilities are similar 
to those in AutoCAD for 
Windows (albeit with a 
slightly reduced set of 
features).

Application menu

Quick Access toolbar

Customize Quick Access toolbar InfoCenter AutoCAD-specific Windows controls

Drawing-specific 
Windows controls

ViewCube

Navigation bar

Status barModel and Layout tabs

Command line

UCS icon

Drawing window

Cursor

Viewport controls
File tab

F I G u r e   1 . 4   AutoCAD 2015 user interface
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Let’s now step through the basic user interface for AutoCAD:

 1. Click the Application menu to open it. Type polygon, and observe 
that the text appears in the search box at the top of the Application 
menu. The search results (see Figure 1.5) list many related AutoCAD 
commands. Search is useful when you’re not sure how to access a com-
mand in the interface or what its exact name is.

F I G u r e   1 . 5   Searching for commands  
in the Application menu

 2. Click the red X at the extreme right edge of the search box to make 
the initial Application menu interface reappear. Here you can create 
new or open existing drawings, export or print drawings, and more. 
Hover the cursor over Open, and then click Drawing (Figure 1.6).

 3. Select the following sample file, and click Open in the Select File dia-
log box:

C:\Program Files\Autodesk\AutoCAD 2015\Sample\
Sheet Sets\Manufacturing\VW252-02-0142.dwg 

If you are using AutoCAD LT, open any of the sample files located 
under C:\Program Files\Autodesk\AutoCAD LT 2015\Sample. 
The Sheet Set Manager appears when the sample file is opened (see 
Figure 1.7). This palette automatically appears when you open any 
drawing that’s a part of a sheet set. AutoCAD has many palettes to 
organize tools and reusable drawing content.

Certification
Objective

Certification
Objective

◀

Sheet sets are not 
available in AutoCAD 
LT, and they are an 
optional feature in 
AutoCAD.
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F I G u r e   1 . 6   Opening a drawing from the Application menu

Palette-properties
menu Tabbed interface

Auto-hide toggle

Palette bar

F I G u r e   1 . 7   Opening a sample drawing reveals the Sheet Set Manager.

 4. Click the Sheet Views tab along the right edge of the Sheet Set 
Manager, and observe that tabs provide a means of accessing addi-
tional interface content. In its present state, the Sheet Set Manager is 
a floating palette. Drag its palette bar, and relocate it on screen.

 5. Click the Auto-hide toggle, and watch the palette collapse to its verti-
cal palette bar; this saves space on screen. Hover the cursor over the 
palette bar, and watch the whole palette reappear so that you can 
access its content. Now toggle Auto-hide off.

▶

Drag floating palettes 
to a secondary moni-
tor if you have one to 
maximize the drawing 
area on your primary 
monitor.



 E x p l o r e  t h e  A u t o C A D  2 0 1 5  f o r  W i n d o w s  U s e r  I n t e r f a c e  7

c01.indd 19-03-2014  08:26 AM 

 6. Click the Palette-properties menu and select Anchor Left. The Sheet 
Set Manager palette is docked along the left edge of the user inter-
face. You can use many options to organize the user interface to 
match the way you work.

 7. Select Sheet Views on the Tabbed interface. Double-click Detail-B 
under 04 – Brush Roller Sub Assy in the Manufacturing sheet set (see 
Figure 1.8). A new drawing appears in the drawing window.

F I G u r e   1 . 8   Docking a palette

 8. Click the Open button in the Quick Access toolbar. Select any draw-
ing in the Manufacturing folder and click Open. If you are using 
AutoCAD LT, open any other sample file.

 9. Move the cursor over the current drawing’s tab and observe two icons. 
Click on Model to open the drawing’s model space (see Figure 1.9).

 10. Move the cursor over the current drawing tab and click Brush Roller 
Sub Assy to reopen the layout.

Certification
Objective

◀

The Quick Access 
toolbar is a convenient 
way to open drawings, 
especially when you’re 
not using the Sheet Set 
Manager.
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F I G u r e   1 . 9   Accessing open drawings and their spaces

 11. Click the Save button on the Quick Access toolbar. The drawing is 
saved locally on your hard drive and a backup copy is also automati-
cally uploaded to your Autodesk 360 account. Close the sample files 
by clicking the X in the upper-right corner of the drawing window. 
However, leave the empty Drawing1 open.

autoCaD Drawing Spaces

AutoCAD has two types of drawing spaces: paper and model. Paper space is a 
two-dimensional area analogous to, and having the dimensions of, a sheet 
of paper. Various sizes of “paper” can be created in individual layouts (see 
Chapter 13, “Working with Layouts and Annotative Objects”). Model space, on the 
other hand, is a single three-dimensional volume where everything is drawn in 
actual size. Model space is typically scaled down in viewports and displayed in 
the paper space of layouts. Most of the drawing you will do in AutoCAD will be in 
model space. A drawing can have only one model space, whereas any number of 
layouts displaying model space through viewports can be saved in the same file.

exercise 1.3: Control the autoCaD ribbon
AutoCAD has so many palettes and ribbon controls that finding the right tool 
for the job can seem like a job in itself. The ribbon is therefore an important fea-
ture that was introduced to AutoCAD 2010. Autodesk adopted Microsoft’s ribbon 
standard to organize the ever-increasing number of toolbars in a single palette, 

▶

You can also switch 
between model and 
layout views using the 
tabs at the bottom-
left corner of the user 
interface.
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making tools much easier to find. Now let’s explore the various ribbon modes 
and identify the user interface elements of each mode.

 1. Open the Customize Quick Access Toolbar menu and choose Workspace. 
Choose the 3D Basics workspace from the drop-down menu in the 
Quick Access toolbar. The ribbon replaces all the Classic menus and 
toolbars (see Figure 1.10). Close the Tool Palettes if it is open.

Workspaces

Workspaces (not to be confused with drawing spaces) are stored sets of user inter-
face controls, which include floating palettes and the configuration of the ribbon. 
People use workspaces to configure the interface quickly for the task at hand.

Tabbed interface Minimize ribbonTypical panel

F I G u r e   1 . 1 0   The full ribbon interface

 2. Click the Minimize Ribbon button, and observe that the full ribbon 
changes to display tabs and panel buttons (see Figure 1.11). Hover the 
cursor over the panel buttons. The buttons expand to reveal all the 
tools shown on the full ribbon.

Panel buttons

Panel titles

Ribbon tabs

F I G u r e   1 . 1 1   Ribbon modes

Certification
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F I G u r e   1 . 9   Accessing open drawings and their spaces
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▶

You can also switch 
between model and 
layout views using the 
tabs at the bottom-
left corner of the user 
interface.
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 3. Click the Minimize Ribbon button again. The panel buttons change 
into panel titles. Hover the cursor again over the titles to reveal each 
panel’s tools.

 4. Click the Minimize Ribbon button once again. Hovering the cursor 
over the tabs doesn’t have any effect. Click the Home tab to reveal the 
full panel temporarily. It disappears after you move the cursor away.

 5. Click the Minimize Ribbon button one last time. The full ribbon 
interface is restored.

 6. Click the Edit button at the bottom of the Edit panel to reveal addi-
tional tools. Hover the mouse over one of the tools to display a tooltip 
that identifies the tool and describes its function. Holding the cur-
sor still a while longer reveals an image that illustrates what the tool 
does (see Figure 1.12).

F I G u r e   1 . 1 2   Tooltip and illustration

 7. Observe that the bottom of the tooltip shown in Figure 1.12 reveals 
the command name (SOLIDEDIT in this case). The ribbon, menus, 
toolbars, and palettes are all graphical alternatives to typing 
commands.

 8. Press and release the Alt key. Keytips appear on the ribbon (see 
Figure 1.13). Pressing any of the letter combinations activates that 
part of the GUI. Type IN, and observe that the Insert tab is selected 
without moving the cursor.

Certification
Objective

▶

I recommend using the 
full ribbon interface 
until you learn the 
location of all the tools. 
Use one of the mini-
mized modes to save 
space on the screen.

AutoCAD is based on 
commands. If you know 
the name of a com-
mand, you can type it 
instead of finding it in 
the GUI.

▶
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F I G u r e   1 . 1 3   Keytips allow you to press keys to  
manipulate the ribbon with the keyboard.

 9. Press the F2 key to open the AutoCAD Text window. The bottom line, 
Command:, is called the command line. It is the active line where com-
mands appear, regardless of whether they are typed or triggered from 
the GUI. The complete history of commands scrolls upward as new 
commands are entered. Close the AutoCAD Text window. Two lines of 
this command history appear at the bottom of the user interface, just 
above the command line that reads “Type a command” by default.

 10. The application status bar contains a coordinate readout on the left 
and a number of status toggle buttons, as shown in Figure 1.14. The 
icons that have arrows adjacent to them open menus. Toggle off all 
the status bar toggles so that none of their icons are highlighted in 
blue. Open the customization menu by clicking the rightmost icon 
on the status bar and deselect Clean Screen, Coordinates, Isometric 
Drafting, and Annotation Monitor from the context menu that 
appears. You can control which buttons appear on the status bar 
using this menu.

Coordinate readout

Customization menuStatus toggles

F I G u r e   1 . 1 4   Status bar

 11. Type POL, and observe how the AutoComplete feature highlights 
commands in alphabetical order as you type (see Figure 1.15). Use 
the arrow keys to move up or down through the list, and press Enter 
when you find the command for which you are looking, or click its 
name in the list, instead of typing the entire word. 

◀

If you undock the 
command line, it can 
be configured to be 
partially transparent 
and to show a number 
of lines of prompt 
history.

◀

Some commands and 
system variables can be 
quite lengthy, so using 
Autocomplete saves 
time typing.
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F I G u r e   1 . 1 5   Command  
line’s AutoComplete feature

 12. Take a look at the InfoCenter at the top right of the screen (see 
Figure 1.16). Click in the search box and type solid.

Search box

Autodesk 360 Product updates

Help
Autodesk Exchange Apps

Search button

F I G u r e   1 . 1 6   InfoCenter

 13. Click the binoculars icon on the right of the search field, and the 
AutoCAD Help dialog box appears. Multiple online books are searched 
and relevant results appear in the left panel. The description of the 
SOLID command appears in the right panel.

 14. Click the Help button on the right edge of the InfoCenter. The Help 
Table of Contents page opens in your browser. All AutoCAD documen-
tation is accessible through this interface.

Set Drawing units
Before you start drawing, it’s important to decide what one drawing unit rep-
resents in the real world. Architects in the United States typically equate one 
drawing unit with one inch in AutoCAD. You need to choose a unit type that 
matches your country’s industry standard.

architectural  Most American architects will choose this type, which displays 
units in feet and inches. For example, 12 feet, 61/2 inches is typed as 12′6-1/2″. 
The hyphen is used to separate inches from fractions of an inch rather than feet 
from inches.

Certification
Objective

▶

The AutoCAD Exchange 
website contains the 
Apps store, where 
you can access free 
and paid apps that 
add functionality to 
AutoCAD.
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Decimal  Metric users should select this type. One decimal unit can be equal 
to one millimeter, one centimeter, or any metric unit that you decide.

engineering  Like the Architectural type, engineering units feature feet and 
inches, but the inches are represented in decimal form—for example, 126.500 feet.

Fractional  American woodworkers often prefer to set AutoCAD drawings in 
fractional units of inches because that is how their work is normally reckoned. 
For example, 12 feet, 61/2 inches reads 150-1/2″ in fractional units.

Scientific  In scientific units, 12.000E+06 is broken down into two parts: 
12.000 indicates 12 accurate to a precision of three decimal places and E+06 
indicates the exponential function raised to the sixth power, or 10 × 10 × 10 ×  
10 × 10 × 10, bringing the total in this example up to 12 million.

exercise 1.4: Set the autoCaD Drawing units
Let’s set the AutoCAD drawing units:

 1. Click the New button on the Quick Access toolbar. Click the arrow 
button next to the Open button in the Select Template dialog box, 
and choose Open With No Template – Imperial (see Figure 1.17).

F I G u r e   1 . 1 7   Opening a drawing with no template

 2. Type UN, and press Enter to bring up the Drawing Units dialog box 
(see Figure 1.18). UN is the command alias (abbreviation) of the UNITS 
command. Most commands have aliases that minimize typing.

Certification
Objective
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F I G u r e   1 . 1 8   Setting drawing units

 3. Select Architectural from the Type drop-down menu. We’re using 
Architectural in this book, but you should select the unit type that 
fits your industry when working professionally. Metric users should 
select Decimal length units.

 4. Click the Length Precision drop-down menu, and select 1/8″ (or 0.0 
for metric). Set Angle Type to Decimal Degrees and Angle Precision 
to 0.0.

 5. Click the Insertion Scale drop-down menu, and select Inches (or 
Centimeters for metric). Click OK to close the Drawing Units  
dialog box.

Now You Know

In this chapter, you’ve learned how to sign in to Autodesk 360, how to open and save sample 
drawings, identify user interface elements, access model- and paperspace, change workspaces, 
control the appearance of the ribbon, type commands using Autocomplete, identify commands 
in the graphical user interface, and set the drawing units.

▶

You can press Enter or 
the spacebar to enter 
commands (command 
names never have 
spaces). Commands 
and their options can 
be typed in upper- or 
lowercase.


